
Xây dựng một ứng dụng web mà không phải viết bất kỳ dòng mã nào, Phần 1 

Cài đặt và định cấu hình cho Rational Application Developer, DB2, WebSphere 

Application Server  

Eric Long, Kỹ sư phần mềm, IBM 

Tóm tắt:  Bạn hãy tìm hiểu làm thế nào để xây dựng một ứng dụng web vững 

chắc. Trong hướng dẫn này bạn hãy tìm hiểu làm thế nào để cài đặt, thiết lập và 

định cấu hình cho các phiên bản dùng thử của Rationa® Application Developer 

dành cho WebSphere® Software, DB2® Enterprise V9.0, và WebSphere 

Application Server V6.1. Trong Phần 2, bạn sẽ sử dụng Rational Application 

Developer để xây dựng một ứng dụng web bằng cách sử dụng dữ liệu từ một cơ sở 

dữ liệu DB2 và xuất bản trang web của bạn lên một WebSphere Application 

Server, bạn thực hiện tất cả điều đó mà không phải viết bất kỳ dòng mã nào. Các 

phần mềm trung gian (Middleware) của IBM thực hiện của tất cả các công việc 

khó khăn đó để bạn có thể tập trung vào lôgic nghiệp vụ của riêng bạn. 

Trước khi bạn bắt đầu 

Về hướng dẫn này  

Nếu bạn là nhà phát triển ứng dụng web, nhà phát triển ứng dụng doanh nghiệp, 

nhà phát triển XML hoặc là một người hiếu kỳ về công nghệ và các công cụ mới 

của IBM thì loạt bài hướng dẫn này là dành cho bạn.  

Hướng dẫn này mô tả cách thức để cài đặt và đặt cấu hình cho Rational 

Application Developer, DB2, WebSphere Application Server. Bạn cũng sẽ xác 

định cấu hình cho các công nghệ này để bắt đầu tạo ra một ứng dụng web (mà bạn 

sẽ kết thúc trong Phần 2). 
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Các yêu cầu cần có trước 

Các bài hướng dẫn này giả định bạn đã có một số hiểu biết về công nghệ Java, 

SQL, và XML. Các kiến thức về thiết kế web là có ích, nhưng không bắt buộc.  

 

  

Yêu cầu về hệ thống  

Không có yêu cầu nào 

 

  

Mô tả sản phẩm  

Trong loạt hướng dẫn gồm hai phần này, bạn sẽ cài đặt và sử dụng các sản phẩm 

của IBM sau đây:  

Rational Application Developer cho WebSphere Software V7.0 

Sản phẩm Rational Application Developer của IBM cho ứng dụng phần 

mềm WebSphere giúp các nhà phát triển Java™ tạo ra Java/ nền Java, 

Enterprise Edition (J2EE), các cổng web, các trang web, các dịch vụ web, 

và các ứng dụng kiến trúc hướng dịch vụ (SOA). Môi trường phát triển tích 
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hợp này giúp bạn nhanh chóng thiết kế, phát triển, lắp ráp, kiểm thử và triển 

khai các ứng dụng này.  

Các công cụ trực quan của Rational Application Developer có thể được 

tăng cường để giảm bớt công việc mã hóa thủ công bằng cách trừu tượng 

hóa mô hình lập trình J2EE, làm cho những người chưa quen với công nghệ 

Java hoàn thành dự án phát triển dễ dàng hơn. Nó được thiết kế để trở thành 

một công cụ phát triển rất linh hoạt, dựa trên khung công tác mở Eclipse, 

với một loạt các tùy chọn cài đặt linh hoạt.  

DB2 Enterprise V9.0 

Sản phẩm DB2 9 (trước đây gọi là Viper) là một máy chủ dữ liệu lai 

(hybrid) hàng đầu, có khả năng hỗ trợ lưu trữ cả dữ liệu quan hệ lẫn 

pureXML™. pureXML cung cấp sự tích hợp liền khối XML với các dữ liệu 

quan hệ, làm tăng tốc độ phát triển, cải thiện hiệu năng tìm kiếm với các chỉ 

mục XML được tối ưu hóa cao, cho phép các thông tin trở thành một dịch 

vụ và nó rất linh động, bởi vì cả hai ngôn ngữ SQL và XQuery đều có thể 

được sử dụng để truy vấn dữ liệu XML.  

WebSphere Application Server V6.1 

WebSphere Application Server V6.1 của IBM là nền móng của nền phần 

mềm WebSphere của IBM, và là một khối xây dựng then chốt của kiến trúc 

hướng dịch vụ (SOA). Cũng giống như Java 2 Enterprise Edition (J2EE™) 

phiên bản đầu tiên và các nền ứng dụng dịch vụ web, WebSphere 

Application Server V6.1 cung cấp một máy giao dịch hiệu suất cao, có thể 

giúp bạn xây dựng, chạy, tích hợp và quản lý các ứng dụng On Demand 

Business™ (kinh doanh theo yêu cầu) năng động. 
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Cài đặt và thiết lập Rational Application Developer 

Để cài đặt và thiết lập Rational Application Developer cho phần mềm WebSphere, 

bạn:  

1. Bắt đầu bằng cách tải về Rational Application Developer. Hướng trình 

duyệt Web tới địa chỉ: 

http://www.ibm.com/developerworks/downloads/r/rad/, như hình bên dưới.  
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Hình 1. Trang tải về phiên bản dùng thử  

 

2. Nhấp vào đường liên kết tải về Multiplatform ở phía dưới cùng của bàn 

điều khiển.  
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3. Bạn cần phải đăng nhập vào developerWorks để truy cập đường dẫn tải về 

các phiên bản dùng thử.  

 

Hình 2. Đăng nhập developerWorks  

 

4. Thực hiện theo các bước của quá trình đăng nhập cho đến khi bạn đến được 

trang tải về.  

5. Từ trang tải về, bạn đánh dấu chọn tất cả các hộp để cài đặt đầy đủ phiên 

bản Rational Application Developer. Đây là một bản tải về rất lớn, nhưng 

bạn có thể tùy chỉnh các phần nào mà bạn muốn tải về, nếu bạn muốn.  
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Hình 3. Trang tải về của Rational Application Developer  

 

6. Tùy thuộc vào chất lượng kết nối internet của mình và số lượng các tùy 

chọn mà bạn chọn, thì đây là lúc bạn có thời gian để nhấm nháp một tách cà 

phê hay xem bộ phim mà bạn yêu thích.  
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Sau khi tất cả các tập tin đã tải về, bạn bắt đầu tiến trình cài đặt.  

7. Bạn tìm đến thư mục của các tập tin đã được tải về. (Nếu bạn đã sử dụng 

công cụ Download Director, thì bạn hãy vào thư mục 

C:\DownloadDirector.)  

8. Mở thư mục để xem các đĩa đã được tải về.  

 

Thư mục tải về Rational Application Developer  

 

9. Nhấn đúp chuột vào thư mục disk1 để mở nó. 

10. Nhấn đúp chuột vào tệp launchpad.exe.  

 

Hình 5. Tệp tin khởi chạy (launchpad) của Rational Application 
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Developer  

 

11. Nhấn vào mục Install IBM Rational Application Developer v7.0.  

 

Hình 6. Cài đặt Rational Application Developer  

 

12. Nếu đây là lần đầu tiên bạn tải về một sản phẩm của IBM, bạn sẽ được gợi 

ý cách cài đặt trình quản lý cài đặt.  

13. Nhấn Next.  
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Hình 7. Thủ thuật trình quản lý cài đặt 

 

14. Bạn chấp nhận các thiết lập mặc định và kết thúc tiến trình cài đặt. 

15. Sau khi trình quản lý cài đặt tiến hành cài đặt, bạn sẽ thấy một bàn điều 

khiển như ở hình 8.  
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Hình 8. Trình quản lý cài đặt 

 

16. Bạn chọn mục Rational Application Developer và tất cả các hộp khác, sau 

đó nhấn Next. 

17. Chấp nhận các chỉ thị mặc định của tất cả các bàn điều khiển cho đến khi 

bạn tới cửa sổ Install Packages để cài đặt các đặc tính cụ thể, như hình bên 

dưới.  
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Hình 9. Các đặc tính của Rational Application Developer 

 

18. Đây là nơi mà bạn chọn tất cả các đặc tính sẽ được cài đặt tại bàn làm việc 

của bạn. Nếu bạn muốn khám phá tất cả những gì mà Rational Application 

Developer có thể cung cấp, thì bạn hãy đánh dấu chọn tất cả.  

19. Nhấn Next. 

20. Nhấn Install. 

Bây giờ bạn đã cài đặt thành công phần mềm Rational Application Developer. 

Bước tiếp theo là cài đặt phần mềm DB2 Enterprise v9.0, như được mô tả trong 

phần kế tiếp.  
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Phần 3. Cài đặt và thiết lập phần mềm DB2 Enterprise v9.0 

Để cài đặt và thiết lập phần mềm DB2 Enterprise v9.0, bạn:  

1. Hướng trình duyệt Web tới địa chỉ: 

http://www.ibm.com/developerworks/downloads/im/udb, như hình bên 

dưới.  

 

Hình 10. Tải về bản dùng thử DB2  

 

2. Chọn liên kết Multiplatform. 

3. Theo cùng quá trình đăng nhập được mô tả trong phần 1 ở trên.  
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4. Nếu bạn sử dụng máy tính Windows 32-bit, bạn hãy chọn bản tải về sau 

đây:  

 

Hình 11. Chọn bản tải về  

 

5. Tại trình duyệt, nhấn vào nút Continue. 

6. Bạn có thể được yêu cầu điền thêm thông tin về việc sử dụng DB2. Sau khi 

hoàn tất các thông tin, bạn nhấn vào nút I confirm. 

7. Đánh dấu chọn vào ô DB2 Enterprise 9 for Windows on 32-bit AMD 

and Intel systems (x86).  

 

Hình 12. Chọn bản tải về  

 

8. Theo các chỉ dẫn của công cụ Download Director để kết thúc tiến trình tải 

về. 

9. Chuyển đến địa chỉ mà các tệp tin được tải về.  
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10. Mở rộng thư mục db2_v9_ese_win_32 > image, và nhấn đúp vào tệp tin 

setup.exe.  

 

Hình 13. Cài đặt  

 

11. Từ trình đơn, chọn mục Install a Product.  

 

Hình 14. Cài đặt sản phẩm  

 

12. Tại mục DB2 Enterprise Server Edition, bạn nhấn Install New.  
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Hình 15. DB2 Cài đặt máy chủ doanh nghiệp mới  

 

13. Bạn theo thủ thuật cài đặt để hoàn tất việc cài đặt máy chủ DB2 Enterprise.  

14. Sau khi bạn nhấn vào nút Finish trên trang cuối cùng thì bạn đã hoàn thành 

việc cài đặt máy chủ DB2 Enterprise.  

Bạn có thể tùy chọn cài đặt trình khách DB2 (DB2 client) để làm việc với máy 

chủ, nhưng trong loạt bài này tôi không nói đến (thay vào đó bạn sẽ sử dụng 

Rational Application Developer).  

 

Phần 4. Cài đặt và thiết lập WebSphere Application Server V6.1 

Để cài đặt và thiết lập WebSphere Application Server V6.1, bạn:  

1. Bắt đầu việc tải về bằng các hướng trình duyệt Web đến địa chỉ: 

http://www.ibm.com/developerworks/downloads/ws/was, như hình bên 

dưới.  
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Hình 16. Trang tải về bản dùng thử  

 

2. Nhấp vào liên kết Multiplatform. 

3. Nhấp vào liên kết Windows. 

4. Một lần nữa, bạn lại được yêu cầu điền thêm thông tin. 

5. Sử dụng công cụ Download Director để tải tập tin cài đặt về máy tính của 

bạn. 

6. Bạn tìm đến địa chỉ mà các tệp tin được tải về.  

7. Giải nén tệp tin was.cd.6100.trial.base.windows.ia32.zip. 

8. Mở rộng thư mục WAS. 

9. Nhấn đúp chuột vào tệp tin install.exe.  
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Hình 17. Tệp tin install.exe của WebSphere Application Server  

 

10. Thủ thuật cài đặt WebSphere Application Server mở ra.  

 

Simpo PDF Merge and Split Unregistered Version - http://www.simpopdf.com



Figure 18. WebSphere Application Server install wizard 

 

11. Bấm Next. 

12. Chấp nhận các điều khoản và nhấp Next. 

13. Kiểm tra để chắc rằng hệ thống của máy tính của bạn đáp ứng các yêu cầu 

cần có.  
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Hình 19. Kiểm tra các điều kiện cần có đối với hệ thống 

 

14. Nhấn Next. 

15. Nhấn chọn hộp Install the sample applications. 

16. Bấm Next. 

17. Chấp nhận địa chỉ cài đặt mặc định. 

18. Nhấn Next. 

19. Tại đây bạn phải bật cho phép quản trị an ninh. Bạn phải đặt mật khẩu cho 

ứng dụng mẫu.  
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Hình 20. An ninh quản trị 

 

20. Nhấn Next. 

21. Xem lại các bản tóm tắt và nhấn Next. 

22. WebSphere Application Server bây giờ đã được cài đặt trên máy tính của 

bạn. Bạn có thể đánh dấu hộp tùy chọn trang Web Start first steps và 

khám phá những đặc tính của WebSphere Application Server V6.1.  

23. Nhấn Finish để hoàn tất việc cài đặt.  
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Kết luận 

Xin chúc mừng! Trong hướng dẫn này bạn đã cài đặt và thiết lập sản phẩm 

Rational Application Developer cho phần mềm WebSphere, DB2 Enterprise v9.0 

và WebSphere Application Server.  

Tại Phần 2 của loạt bài hướng dẫn này, bạn sẽ học cách xây dựng từ đầu một ứng 

dụng web, ứng dụng này kết nối đến cơ sở dữ liệu DB2 và được xuất bản trên 

WebSphere Application Server, mà không cần phải viết một dòng mã nào.  
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Xây dựng một ứng dụng web mà không phải viết bất kỳ dòng mã nào, Phần 2 

Xây dựng ứng dụng bằng cách sử dụng Rational Application Developer, DB2 và 

WebSphere Application Server  

Eric Long, Kỹ sư phần mềm, IBM 

Tóm tắt:  Bạn hãy tìm hiểu cách sử dụng Rational® Application Developer để 

xây dựng một ứng dụng web bằng cách sử dụng dữ liệu từ cơ sở dữ liệu DB2® và 

xuất bản trang web của bạn lên WebSphere® Application Server, mà không phải 

viết một dòng mã nào. Trong hướng dẫn này, các phần mềm trung gian 

(middleware) của IBM thực hiện của tất cả các công việc khó khăn để bạn có thể 

tập trung vào lôgic nghiệp vụ của riêng bạn. Phần 1 chỉ dẫn cho bạn cách cài đặt, 

thiết lập và định cấu hình cho các phiên bản dùng thử của Rational® Application 

Developer dành cho WebSphere® Software, DB2® Enterprise V9.0, và 

WebSphere Application Server V6.1. Phần 2 chỉ cho bạn cách xây dựng một ứng 

dụng. 

Trước khi bạn bắt đầu 

Về bài hướng dẫn này 

Nếu bạn là nhà phát triển ứng dụng web, phát triển ứng dụng doanh nghiệp, nhà 

phát triển XML hoặc là một người hiếu kỳ về công nghệ và các công cụ mới của 

IBM thì loạt bài hướng dẫn này là dành cho bạn.  

Hướng dẫn này chỉ dẫn cách làm thế nào để tạo ra một cơ sở dữ liệu DB2, điền dữ 

liệu, liên kết cơ sở dữ liệu tới Rational Application Developer, xây dựng một dự 

án Web với Rational Application Developer, tạo ra một trang JSP với các giá trị 

của cơ sở dữ liệu của bạn và xuất bản dự án lên WebSphere Application Server 

V6.1.  
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Một số yêu cầu 

Hướng dẫn này giả định bạn có một số hiểu biết về công nghệ Java™ SQL, và 

XML. Kiến thức về thiết kế web là có ích, nhưng không bắt buộc.  

 

  

Yêu cầu về hệ thống  

Bạn cần phải hoàn thành các nhiệm vụ trong Phần 1, cài đặt và định cấu hình cho 

Rational Application Developer, DB2, và WebSphere Application Server, trước 

khi bắt đầu hướng dẫn này.  

 

  

Mô tả sản phẩm  

Rational Application Developer cho WebSphere Software V7.0  

Sản phẩm Rational Application Developer của IBM cho ứng dụng phần 

mềm WebSphere giúp các nhà phát triển Java™ Sản phẩm Rational 

Application Developer của IBM cho ứng dụng phần mềm WebSphere giúp 

các nhà phát triển Java™ tạo ra Java/ nền Java, Enterprise Edition (J2EE), 

các cổng web, các trang web, các dịch vụ web, và các ứng dụng kiến trúc 
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hướng dịch vụ (SOA). Môi trường phát triển tích hợp này giúp bạn nhanh 

chóng thiết kế, phát triển, lắp ráp, kiểm thử và triển khai các ứng dụng này.  

Các công cụ trực quan của Rational Application Developer có thể được 

tăng cường để giảm bớt công việc mã hóa thủ công bằng cách trừu tượng 

hóa mô hình lập trình J2EE, làm cho những người chưa quen với công nghệ 

Java hoàn thành dự án phát triển dễ dàng hơn. Nó được thiết kế để trở thành 

một công cụ phát triển rất linh hoạt, dựa trên khung công tác mở Eclipse, 

với một loạt các tùy chọn cài đặt linh hoạt.  

DB2 Enterprise V9.0  

Sản phẩm DB2 9 (trước đây gọi là Viper) là một máy chủ dữ liệu lai 

(hybrid) hàng đầu, có khả năng hỗ trợ lưu trữ cả dữ liệu quan hệ lẫn 

pureXML™. pureXML cung cấp sự tích hợp liền khối XML với các dữ liệu 

quan hệ, làm tăng tốc độ phát triển, cải thiện hiệu năng tìm kiếm với các chỉ 

mục XML được tối ưu hóa cao, cho phép các thông tin trở thành một dịch 

vụ và nó rất linh động, bởi vì cả hai ngôn ngữ SQL và XQuery đều có thể 

được sử dụng để truy vấn dữ liệu XML. 

WebSphere Application Server V6.1  

WebSphere Application Server V6.1 của IBM là nền móng của bộ phần 

mềm WebSphere của IBM, và là một khối xây dựng then chốt của kiến trúc 

hướng dịch vụ (SOA). Cũng giống như Java 2 Enterprise Edition (J2EE™) 

phiên bản đầu tiên và các nền ứng dụng dịch vụ web, WebSphere 

Application Server V6.1 cung cấp một máy giao dịch hiệu suất cao, có thể 

giúp bạn xây dựng, chạy, tích hợp và quản lý các ứng dụng On Demand 

Business ™ (kinh doanh theo yêu cầu) năng động. 
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Phần 2. Tạo ra và điền dữ liệu một cơ sở dữ liệu và các bảng DB2 mới 

Trong phần này bạn sẽ tìm hiểu cách làm thế nào để sử dụng Trung tâm điều khiển 

của DB2 để xây dựng và điền dữ liệu cho một cơ sở dữ liệu và bảng mới.  

Với Trung tâm điều khiển, bạn có thể:  

 Thêm hệ thống cơ sở dữ liệu DB2, các hệ thống liên hiệp (federated), các 

hệ thống DB2 UDB cho z/OS và OS/390® IMSysplexes, các cá thể, các cơ 

sở dữ liệu và các đối tượng cơ sở dữ liệu vào cây đối tượng. 

 Quản lý các đối tượng của cơ sở dữ liệu: Tạo, thay đổi và hủy các cơ sở dữ 

liệu, các vùng bảng, các bảng, khung nhìn, chỉ mục, các kích hoạt (triggers) 

và các lược đồ.  

 Quản lý người sử dụng.  

 Quản lý dữ liệu: Nạp, nhập, xuất và tổ chức lại dữ liệu. Bạn cũng có thể thu 

thập số liệu thống kê.  

 Thực hiện các bảo trì phòng ngừa bằng cách sao lưu và khôi phục lại cơ sở 

dữ liệu hoặc các vùng bảng.  

 Định cấu hình và tinh chỉnh các cá thể và cơ sở dữ liệu.  

 Quản lý kết nối cơ sở dữ liệu, chẳng hạn như các máy chủ DB2 Connect™ 

và các hệ thống con.  

 Quản lý hệ thống IMS. 

 Quản lý hệ thống con DB2 UDB cho z/OS và OS/390.  
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 Quản lý các ứng dụng.  

 Phân tích các truy vấn bằng cách sử dụng Visual Explain để xem các kế 

hoạch truy cập.  

 Khởi chạy các công cụ khác, chẳng hạn như Trình biên tập lệnh và Trung 

tâm kiểm tra tình trạng hệ thống (Command Editor và Health Center). 

Xây dựng cơ sở dữ liệu mới DWORKS của DB2  

Sau khi bạn đã hoàn thành Phần 1 của loạt bài hướng dẫn này, bạn cần phải có tài 

khoản đăng nhập mới và khái lược (profile) người dùng là db2admin.  

1. Kiểm tra để chắc chắn rằng bạn đã đăng nhập vào hệ điều hành với tên 

db2admin (hoặc người sử dụng có quyền của quản trị viên DB2). 

2. Mở cửa sổ dòng lệnh và chạy db2start, như hình bên dưới.  

 

Hình 1. Chạy db2start  

 

3. Mở Trung tâm điều khiển và chạy db2cc.  
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Hình 2. Chạy db2cc  

 

4. Nhấn nút OK tại cửa sổ Control Center View và chọn Advanced.  

 

Hình 3. Cửa sổ Control Center View 

 

5. Chào mừng bạn đến với Trung tâm điều khiển của DB2 IBM. Nhấn chuột 

phải vàoAll Databases và chọn Create Database > Standard....  
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Hình 4. Tạo một cơ sở dữ liệu tiêu chuẩn  

 

6. Thủ thuật Create Database mở ra – đây là một trong nhiều thủ thuật sinh ra 

mã cho bạn. 

7. Đặt tên cơ sở dữ liệu là DWORKS. 

8. Bạn phải đánh dấu chọn hộp Enable database for XML (Code set will be 

set to UTF-8).  

Một trong những cải tiến lớn nhất của DB2 V9 là khả năng xử lý các tài 

liệu XML như một kiểu nguyên thủy. Bạn không còn phải lo lắng về việc 

chia nhỏ tài liệu hoặc coi chúng như những đối tượng lớn ( CLOB, BLOB, 

v.v..).  

9. Trang đầu tiên của thủ thuật giống như hình 5.  
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Hình 5. Thủ thuật tạo cơ sở dữ liệu - Trang 1 (Name - Đặt tên) 

 

10. . Nhấn Next. 

11. Tại trang 2 (Storage - Lưu trữ), bạn chấp nhận đường dẫn mặc định tới kho 

lưu trữ.  

12. Nhấn Next. 

13. Tại trang 3 (Region - Vùng), chấp nhận vùng mặc định.  
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14. Nhấn Next. 

15. Xem lại trang 4 - (Summary -Tóm tắt), trang này như hình ở dưới.  

 

Hình 6. Thủ thuật tạo cơ sở dữ liệu - trang 4 (Summary-Tóm tắt)  

 

16. Nhấn Finish. 

Bây giờ bạn đã tạo ra một cơ sở dữ liệu mới, bước tiếp theo là xây dựng một bảng 

và điền dữ liệu cho nó.  
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Xây dựng bảng CITIES (Các thành phố) mới 

1. Tại Trung tâm điều khiển, mở rộng cơ sở dữ liệu DWORKS. 

2. Nhấn vào thư mục Tables để xem tất cả các bảng hiện có.  

 

Hình 7. Các bảng của DWORKS 

 

3. Nhấn chuột phải vào thư mục Tables và chọn Create....  
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Thao tác này mở ra thủ thuật tạo bảng.  

4. Đặt tên bảng là CITIES và đưa vào thêm lời chú thích như tại hình 8.  

 

Hình 8. Thủ thuật tạo bảng - trang 1 (Name - Đặt tên)  

 

5. Nhấn Next. 

6. Trên trang 2 (Columns – các cột), nhấn Add.... 
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7. Đặt tên cột là ID. 

8. Từ trình đơn thả xuống bạn chọn INTEGER làm kiểu dữ liệu. 

9. Chấp nhận các mặc định còn lại, như tại hình 9.  

 

Hình 9. Thêm cột ID  

 

10. Nhấn OK. 
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11. Lặp lại các bước tương tự trên cho cột CITY bằng cách sử dụng các thông 

tin bên dưới.  

 

Hình 10. Thêm cột CITY  

 

12. Nhấn OK. 

13. Lặp lại các bước tương tự trên cho cột STATE bằng cách sử dụng các 

thông tin bên dưới.  
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Hình 12. Thêm cột STATE 

 

14. Nhấn OK. 

15. Lặp lại các bước tương tự trên cho cột COUNTRY bằng cách sử dụng các 

thông tin tại hình 12  
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Hình 12. Thêm cột COUNTRY 

 

16. Nhấn OK. 

17. Nhấn Next. 

18. Tại trang 3 (Data Partitions - Phân vùng dữ liệu), chấp nhận các giá trị mặc 

định.  

19. Nhấn Next. 

20. Tại trang 4 (Table spaces - Vùng bảng), chấp nhận các giá trị mặc định.  
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21. Nhấn Next. 

22. Tại trang 5 (Keys - Các khóa), nhấn Add Primary.... 

23. Đặt tên khóa chính là PRIMARY_ID. 

24. Tại mục Available columns, bạn chọn ID. 

25. Nhấn vào nút hình mũi tên > . 

26. Cửa sổ Define Primary Key (định nghĩa khóa chính) giống như Hình 13.  

 

Hình 13. Cửa sổ Define Primary Key 

 

27. Nhấn OK. 

28. Nhấn Next. 

29. Bạn sẽ không sử dụng tùy chọn gộp bó dữ liệu (data clustering) tại trang 6 

(Dimensions-Các chiều), do đó bạn chấp nhận giá trị mặc định và nhấn 

Next. 

Simpo PDF Merge and Split Unregistered Version - http://www.simpopdf.com



30. Tại trang 7 (Constraints-Các ràng buộc), chấp nhận các giá trị mặc định và 

nhấn Next. 

31. Tại trang 8 (Review-Xem lại), nhấn Show SQL để xem những gì mà Trung 

tâm điều khiển đã viết cho bạn.  

 

Hình 14. Cửa sổ Show SQL 

 

32. Nhấn Close tại cửa sổ Show SQL. 

33. Nhấn Finish tại cửa sổ Create Table Wizard. 

34. Bạn sẽ thấy một thông báo của DB2 đã thi hành các SQL mà bạn vừa xem.  

35. Nhấn Close. 

 

  

Điền dữ liệu cho bảng CITIES mới 

1. Cuộn danh sách các bảng xuống đến mục CITIES và nhấn đúp chuột vào 

nó.  
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Hình 15. Bảng CITIES 

 

2. Thay vì vất vả với SQL, Trung tâm điều khiển của DB2 cung cấp một trình 

soạn thảo hấp dẫn, như hình dưới đây, để thêm dữ liệu vào các bảng.  
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Hình 16. Bảng CITIES 

 

3. Nhấn Add Row. 

4. Nhập giá trị 1 cho mục ID.  

5. Nhập tên Austin cho mục CITY.  

6. . Nhập tên Texas cho mục STATE.  

7. . Nhập tên USA cho mục COUNTRY.  
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8. Lặp lại cùng các bước trên cho đến khi bảng của bạn trông như hình 17.  

 

Hình 17. Bảng CITIES 

 

9. Nhấn Commit. 

10. Nhấn Close.  

Xong rồi ! Bạn đã tạo ra một cơ sở dữ liệu, một bảng và các dữ liệu đã 

được bổ xung vào bảng mà không cần viết một dòng mã nào.  

11. Đóng Trung tâm điều khiển của DB2 lại.  
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Trong phần tiếp theo bạn sẽ xem cách tích hợp cơ sở dữ liệu CITIES với Rational 

Application Developer và WebSphere Application Server.  

 

 

 

 

 

Tích hợp  

Trong phần này, bạn tìm hiểu cách để tích hợp cơ sở dữ liệu CITIES với Rational 

Application Developer và WebSphere Application Server.  

1. Chạy Rational Application Developer cho phần mềm WebSphere. 

(Đối với hệ điều hành Windows, bạn nhấn Start > All Applications > IBM 

Software Development Platform > IBM Rational Application 

Developer > IBM Rational Application Developer.) 

2. Tại cửa sổ Workspace launcher (khởi chạy vùng làm việc) nhấn OK.  

Các vùng làm việc về bản chất là nơi mà tất cả mọi việc của bạn diễn ra ở 

đây. Tất cả các tệp tin, các tạo tác, các siêu dữ liệu và tất cả những thứ 

tương tự cùng với tất cả mọi thứ được tạo ra trong Rational Application 

Developer được lưu giữ trong vùng làm việc của bạn.  
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3. Bảng Welcome (Chào mừng) là nguồn tài nguyên lớn để học tất cả những 

gì liên quan đến Rational Application Developer, nhưng chúng ta sẽ bỏ qua 

trong hướng dẫn này.  

4. Đóng bảng điều khiển “Chào mừng” bằng cách nhấn chuột vào nút X bên 

cạnh chữ Welcome.  

 

Hình 18. Đóng bảng điều khiển Chào mừng 

 

5. Chào mừng bạn đến với sản phẩm Rational Application Developer. Đây là 

khung nhìn phối cảnh mặc định của J2EE.  

6. Từ trình đơn chính, chọn Window > Preferences....  

 

Simpo PDF Merge and Split Unregistered Version - http://www.simpopdf.com



Hình 19. Chọn Window > Preferences... 

 

7. Mở rộng nút General và nhấn Capabilities. 

8. Bạn phải đánh dấu chọn các khả năng như hình dưới đây  
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Hình 20. Các mục đã chọn trong khung nhìn Capabilities 

 

9. Nhấn Apply. 

10. Nhấn OK. 

11. Bây giờ bạn có thể kết nối tới cơ sở dữ liệu CITIES từ Rational Application 

Developer.  
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12. Từ trình đơn chính, bạn chọn Window > Show View > Other.... 

13. Mở rộng thư mục Data. 

14. Nhấn Database Explorer.  

 

Hình 21. Hộp thoại Show View (hiển thị các khung nhìn) 

 

15. Nhấn OK. 

16. Tại khung nhìn Database Explorer, bạn mở rộng mục Connections (các kết 

nối).. 

17. . Rational Application Developer tìm kiếm tất cả các cơ sở dữ liệu có sẵn 

trong ổ đĩa cứng của bạn. Bạn sẽ tìm thấy cơ sở dữ liệu DWORKS.  
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Hình 22. Cơ sở dữ liệu DWORKS 

 

18. Nhấn chuột phải vào DWORKS và chọn Reconnect. 

19. Nhập ID đăng nhập của bạn và mật khẩu (chính các thông tin mà bạn đã sử 

dụng trong phần trước).  

20. Nhấn OK. 

21. Bây giờ bạn có quyền truy cập đầy đủ vào tất cả các dữ liệu CITIES tại 

Rational Application Developer. 

22. Mở rộng DWORKS > DWORKS > Schemas > DB2ADMIN (hoặc tên 

người dùng tuỳ chỉnh của bạn) > Tables. 

23. Bạn sẽ tìm thấy bảng CITIES được tạo ra trước đó.  
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Hình 23. Bảng CITIES  

 

24. Nhấn chuột phải vào CITIES và chọn Data > Sample Contents. 

25. Khung nhìn Data Output sẽ tự động mở ra, kết xuất toàn bộ dữ liệu của 

bảng CITIES. 

Bạn cũng có thể thao tác dữ liệu tại CITIES bằng cách sử dụng các trình 

đơn bối cảnh, các thủ thuật, các trình biên tập của Rational Application 

Developer.  
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Hình 24. Bảng CITIES  

 

26. Đóng khung nhìn Data Output lại. 

27. Nhấn vào nút Servers ở bên trái của khung nhìn Database Explorer.  

Bạn hãy lưu ý cách mà chế độ chạy thi hành (runtime) của máy chủ 

WebSphere Application Server V6.1 đã được tạo ra như thế nào. Bạn sẽ sử 

dụng chế độ chạy thi hành này trong phần kế tiếp.  

Phần này cho bạn thấy tất cả các sản phẩm Rational Application Developer, DB2 

và WebSphere có thể được tích hợp với nhau dễ dàng như thế nào.  
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